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Agenda

= Eclipse
— caratteristiche generali
— importazione/creazione di un progetto di esempio
— funzionalita di ausilio alla scrittura del codice

— compilazione, collaudo ed esecuzione di un'applicazione
— gestione tramite ANT

= Applicazioni Web
— awvio e gestione del server Tomcat
— deploy da filesystem e da Eclipse
— debug remoto e locale

= Editor HTML, CSS, Javascript

— Flrefox for Developer, Google Chrome Developer Tools, Visual Studio
Code
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Eclipse, caratteristiche generali

= Ambiente integrato di sviluppo (IDE)
— interamente scritto in Java
— multipiattaforma (Win/Mac/Linux/...)
— multi-linguaggio (tool anche per programmazione linguaggio C ad es.)
— open source (controllato dalla Eclipse Foundation)

= Architettura basata su tecnologie core e plug-in
— fortemente modulare ed espandibile

— adattabile (e adattato) alle piu diverse esigenze attraverso l'installazione di
cosiddetti “plug-in”

& eclipse IDE

2020-03
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Configurare il proprio ambiente di lavoro

Strumenti gia presenti in laboratorio, ma a casa...
Java JDK e JRE (versione 11)

— https://www.oracle.com/java/technologies/javase-jdk11-downloads.html

Eclipse IDE (2020-03 for Java Enterprise Edition Developers)
— https://www.eclipse.org/downloads/packages/

— https://www.eclipse.org/downloads/packages/release/2020-03/r/eclipse-
ide-enterprise-java-developers-includes-incubating-components

— http://eclipsetutorial.sourceforge.net/
— http://eclipsetutorial.sourceforge.net/totalbeginner.html

Tro u bleS hOOtI ng Eclipse IDE for Enterprise Java Developers
http .//WWW qooq Ie Com/ 353MB 543,531 DOWNLOADS
- - - - Tools for Java developers creating Enterprise Java and Web applications, Windows 64'b%t

B including a Java IDE, tools for Enterprise Java, JPA, JSF, Mylyn, Maven, Git and .“, Mac Cocoa 64-bit

i more. Linux 64-bit
Click here to file a bug against Eclipse Web Tools Platform.
Click here to file a bug against Eclipse Platform.
Click here to file a bug against Maven integration for web projects.
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Primo impatto

Avviare Eclipse per la prima volta
— scelta del direttorio per il Workspace (dove verranno salvati i progetti)
— Welcome... eccetera: — close
— dovesse mai servire di nuovo: Help — Welcome

Workbench (area di lavoro) costituita da un insieme di View
(viste)

— Package View (struttura logica dei progetti)

— Navigator View (struttura dei file su disco)

— Java Editor (scrittura del codice)

— Outline View (struttura del file aperto nell'editor)

— Console (stdout e stderr prodotti dalle attivita eseguite)

— Problems (primo luogo dove guardare quando qualcosa va storto!!!)
...e tante altre: Window — Show view

Perspective (prospettiva) come associazione di un preciso
insieme di viste, in precise posizioni, per affrontare determinate
operazioni (codifica, debug, Web, condivisione su SVN...)

— Windows — Open perspective
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Perché un IDE

= Numerose funzionalita “di comodo” per velocizzare la scrittura
del codice e garantire la sua correttezza a tempo di
compilazione
— supporto per il refactoring (nomi di package, classe, metodi, variabili, ...)
— generazione automatica di codice (costruttori, metodi getter/setter, ...)
— evidenziazione (parole chiave del linguaggio, errori, ...)
— messaggqi di errore e consigli per risoluzione (a volte automatica)

— autocompletamento (parentesi, nomi delle variabili,
modificatori di tipo, ...): si attiva da solo dopo un istante, o su
comando: Ctrl+Space

= Tantissime funzionalita
— right-click dovunque :)
— menu Help — Search
— sito di Eclipse, tutorial on-line (spesso persino animati)
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Gestione dei progetti

= Creazione
— File - New — Java Project / Project...

= |mportazione da file zip (esempi del corso)

— File — Import — General — Existing Projects into Workspace — Next
— Select archive file Pe——

:::::::

nota bene: nel workspace non possono
esistere piu progetti con lo stesso nome

Occorre cancellare o rinominare quello
gia esistente, prima di importarne uno con :
lo stesso nome: diversamente, il progetto =)

"“omonimo" contenuto nel file ZIP

non viene visualizzato tra i progetti -
individuati nell'archivio
ERRORE COMUNE nelle prime
esperienze di lab s
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Importazione di un progetto

= All'interno dell'archivio ZIP dell'esercitazione, nel direttorio
progetti
— il file 00_TecWeb.zip contiene un semplice progetto Java di esempio

— creato con Eclipse: contiene gia tutti i descrittori necessari a essere
riconosciuto e configurato correttamente

= |mportare il progetto come appena visto, senza esploderne
I'archivio su file system (lo fara Eclipse)

= Problemi? (librerie, versioni JRE, versioni del compilatore, ...)
— vista Problems View: diagnosi
— ...a breve li risolveremo
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Struttura del progetto

All'interno della directory radice

src: sorgente (file .java) dell'applicazione da sviluppare

test: sorgente delle routine di test (opzionali) che verificano il corretto
funzionamento dell'applicazione

LIBRERIE (visualizzazione puo variare da versione a versione di Eclipse):
codice fornito da terze parti necessario allo sviluppo

* JRE le classi base del runtime di Java (es: java.lang.String)

+ API e loro eventuale implementazione riferita dall'applicazione (es: JUnit per i
test, ogqi; specifiche J2EE per lo sviluppo di Servlet, in future esercitazioni)

ant: strumenti per I'esecuzione automatica di operazioni
» compilazione, esecuzione dei test, packaging, distribuzione, ...

lib: direttorio che fisicamente contiene gli archivi .jar delle librerie in uso nel
progetto (nota: alcune versioni di Eclipse “nascondono” le librerie aggiunte
al build-path, onde evitare di visualizzare informazioni “doppie”)

resources: altre risorse da allegare alla versione distribuibile del progetto
(immagini, file multimediali, ...)

tmp: direttorio per scopi temporanei
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Compilazione, collaudo, esecuzione

Poche semplici classi
— logica di business
— routine per il collaudo automatizzato
— avvio dell'applicazione

Completamento del progetto:

— correzione errori (autocompletamento), importazioni mancanti (organize imports),
creazione dei metodi richiesti (autogenerazione sorgente, quickfix), ecc...

Esecuzione dei test

— analisi della struttura di una suite di test
« Ulteriori informazioni su http.//junit.sourceforge.net/#Documentation)

— apertura della classe che realizza la suite Junit: Esegui come... — JUnit Test
— aggiunta di ulteriori test (es: corretto funzionamento metodi getter/setter)

Awvio dell'applicazione
— apertura della classe che contiene il metodo main ()
— scrittura del metodo: Esegui come... — Java application
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ANT

Lo sviluppo di un‘applicazione richiede di eseguire tipiche
sequenze di operazioni

— scrittura del codice sorgente, compilazione, collaudo, packaging,
distribuzione, ...

Alcune di queste operazioni sono ripetitive e la loro esecuzione
puo richiedere azioni diverse in ambienti di sviluppo diversi

— posizioni e convenzioni dei file su disco e convenzioni di nome

— posizione e nome di menu e pulsanti nei diversi ambienti di sviluppo (e
spesso anche in diverse versioni dello stesso ambiente)

Strumenti di sviluppo come ANT (o Maven, o altri, ...), detti build
tool, permettono invece di

— definire una volta per tutte le operazioni da compiere
— eseguire tali operazioni in maniera automatica
— fare tutto questo in maniera indipendente dall'lDE utilizzato
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build.xml

= ANT € a sua volta realizzato in Java e configurato mediante file XML

» Permette di definire in maniera leggibile e facilmente modificabile un
insieme di obiettivi (target) il cui raggiungimento permette di
completare le diverse fasi di sviluppo del progetto

— inizializzazione, compilazione, collaudo, packaging, ...
— relazioni di dipendenza

— definizione di proprieta (property) mediante variabili di tipo write-once che &
possibile riferire all'interno dei diversi obiettivi

= Non esistono obiettivi predefiniti, ma ciascuno e definito attraverso
I'indicazione di una o piu operazioni (task)
— copia di file, compilazione, creazione di archivi, ...

= ANT rende disponibili una serie di operazioni predefinite (core task) e
prevede una serie di operazioni opzionali (optional task) dipendenti
da librerie di terze parti

— € inoltre possibile definire nuovi “task”, attraverso apposite classi Java
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Uso di ANT ai fini delle esercitazioni

L'insegnamento di ANT non ¢ tra gli obiettivi del corso, ma il suo uso “ai
morsetti” permette di:

— rendere ciascuno studente in grado di eseguire le operazioni “di contorno” richieste _
dall'esercitazione, in modo efficiente e indipendente dagli specifici OS e IDE e dai diversi
percorsi locali su file system

— mantenere traccia delle operazioni svolte e di come esse sono realizzate, attraverso il
contenuto del file build.xml

Istruzioni per l'uso:

— ant/build.xml: definizione de?Ii obiettivi da completare (nonostante sia possibile
modificare ed estendere tale file a piacimento, esso € concepito per poter essere usato
senza alcuna modifica)

— ant/environment.properties: proprieta richiamate da build.xml che differiscono da
macchina a macchina e sono quindi tipicamente DA MODIFICARE

Accorgimenti:
— € possibile lanciare ant da riga di comando
+ cd $PROJECT_HOME/ant
* ant <nome_obiettivo>

— € possibile lanciare ant dall'interno di Eclipse (in questo caso, se ne eredita la
JAVA HOME):

e Windows — Show view — Other.. — Ant — Ant
e Trascinare il file build.xml nella nuova vista
» Eseguire un obiettivo tramite double-click
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Funzionalita avanzate - Debug

Attraverso I'IDE, é possibile seguire passo-passo il flusso di un
programma.
— specificare opportuni breakpoint nei quali interrompere e monitorare
I'esecuzione
* ad esempio, nella classe HelloWorld. java...

« ...left-click oppure right-click — toggle breakpoint sulla fascia grigia a sinistra del codice,
nell'editor principale

— eseguire il programma in modalita debug dall'interno dell'IDE stesso

 right click — Debug come... — Java application sulla classe contenente il metodo
main()

In caso di successo, la prospettiva corrente dell'lDE si modifica per
esporre le tipiche funzionalita da debug

Possibili operazioni:
— giocare con i comandi Play/Pause, Step into, Step over, Step return
— controllare il valore run-time delle variabili nella vista Variables
— eccetera... eccetera...
e cambiare il valore di una variabile,
* ispezionare il risultato di un'espressione,
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Debug di applicazioni “remote”

= Tuttavia...
— le applicazioni “tradizionali” non eseguono all'interno dell'IDE...

— in particolare, le applicazioni “Web” eseguono all'interno di opportuni server
“contenitori”

= Per poter fare debugging di tali applicazioni & quindi necessario
imparare ad eseguire l'applicazione in esame e lo strumento di
debug come processi separati, che comunicano attraverso la rete
— specificare opportuni breakpoint nell'applicazione d'esempio
— modificare il suo metodomain() affinché non termini subito!
+ es: ciclo for + attese
— lanciare il programma come applicazione Java indipendente con I'opzione...
« -Xdebug -Xrunjdwp:transport=dt_socket,address=$PORT,server=y,suspend=n
» nel file build.xml & gia presente uno specifico obiettivo
— creare (e poi avviare) una apposita “Debug configuration” nell'lDE

* Run — Debug configurations... — Remote Java application — right-click —
New...

 ...eindicare la stessa porta di ascolto $PORT
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Apache Tomcat (1)

Un semplice Web Server, sviluppato e distribuito dalla
fondazione Apache, interamente scritto in Java

— permette di pubblicare siti Web

— fornisce I'ambiente di esecuzioni per applicazioni Web scritte in accordo
alle specifiche Java Servlet e JSP

— In questo corso utilizzeremo la versione 9.0.22

Installazione del server

— download dal sito ufficiale https://archive.apache.org/dist/tomcat/tomcat-
9N9.0.22/bin/apache-tomcat-9.0.22.zip  oppure

— dal path C:\\Applicativi\TecnologieWeb del file system dei PC client LAB
oppure
— dalla intranet universitaria (sito del corso)

— estrazione del contenuto del file ZIP
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9/v9.0.22/bin/apache-tomcat-9.0.22.zip  oppure

— dal path C:\\Applicativi\TecnologieWeb del file system dei PC client LAB
oppure
— dalla intranet universitaria (sito del corso)

— estrazione del contenuto del file ZIP
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Apache Tomcat (2)

Tomcat € uno dei Web Server piu utilizzati sia sul mercato che
nel settore dell’education

Tomcat € un Web Server STAND-ALONE

= Non ha bisogno di un IDE (e.g., Eclipse) per funzionare

= anche se, come vedremo a breve, il suo uso integrato con Eclipse puo
semplificarci la vita ai fini del corso...

» |l deploy di web application, debug remoto, ed operazioni di tuning possono
essere fatte indipendentemente dal tipo di IDE che si utilizza, evitando cosi
il vincolo molto stringente di un IDE specifico

Per dare una panoramica completa, nel seguito verra illustrato il
suo utilizzo in entrambe le modalita:

» standard STAND-ALONE e
» integrata con I'IDE Eclipse
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Avvio di Apache Tomcat (STAND-ALONE)

E necessario impostare la variabile d'ambiente JRE_. HOME o
JAVA HOME affinché “indichi” un'installazione JDK con
versione >= 1.6

export JRE_HOME=.... (linux; per verificare: echo $PROVA)

SET JRE_HOME-=... (windows; per verificare: echo %PROVA%)

Lanciare il server attraverso il comando
TOMCAT_HOME/bin/startup.sh  (linux)
TOMCAT_HOME/bin/startup.bat (windows)

Controllare il corretto avvio

— nei log del server stesso
+ tail -f TOMCAT_HOME/logs/catalina.out (linux)
* popup e/o notepad.exe TOMCAT_HOME/logs/catalina.out (windows)

— accedendo a http://localhost:8080/
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Eclipse & Tomcat (1)

Eclipse dispone di un‘apposita perspective per facilitare la
creazione di applicazioni Web

*  Windows — Open Perspective — Other... — Web

Creazione di un semplice progetto Web
= File — New — Other... — Web — Dynamic Web Project

» vedremo a lezione la struttura di un'applicazione Web; per ora limitiamoci
a realizzare un semplice test con servilet e JSP

Creazione Servlet

» tasto destro del mouse sul nome del progetto e poi
New — Other... — Web — Servlet

» inserire nel metodo doGet della classe creata la seguente istruzione:
response.getOutputStream().printin("ciao da TestServiet.doGet");

Creazione JSP

= tasto destro del mouse sul nome del progetto e poi
New — Other... — Web — JSP File

» inserire nel body del file creato la seguente riga:
ciao da TestJsp.jsp <%= new java.util.Date() %>
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Eclipse & Tomcat (2)

Problemi di compilazione: mancano le librerie per le servlet

1) prelevare servlet-api.jar da Tomcat (directory lib), copiare nel progetto (directory
lib) ed inserire tale jar nel path del progetto

2) gestione di un server direttamente da Eclipse (vedremo poi)

Creare il file WAR che contiene tutte le informazioni necessarie per
effettuare il deploy

=  Export — WAR file
= spostare il file creato nella directory webapps di Tomcat
= attendere pochi secondi e controllare la directory webapps
» testare tramite
= http://127.0.0.1:8080/nome-progetto/nome-servlet
= http://127.0.0.1:8080/nome-progetto/nome-jisp

Metodo di deploy tramite interfaccia grafica
= http://127.0.0.1:8080/ — Manager App

* ma bisogna aggiungere un utente di tipo "manager-gui" nel file di configurazione
di Tomcat conf/ftomcat_users.xml, e.g., <user username="studente"
password="tomcat" roles="manager-gui"/>
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Esecuzione in modalita “debug remoto” (poco pratico)

Per poter eseguire Tomcat in modalita “debug” & necessario modificarne lo script di
avvio, tedioso e poco consigliato
— in Windows modificare bin/startup.bat ed aggiungere
- set JPDA_ADDRESS=8787
- set JPDA_TRANSPORT=dt_socket
— in Linux modificare bin/startup.sh ed aggiungere
— export JPDA_ADDRESS=8787
— export JPDA_TRANSPORT=dt_socket
— inoltre cercare la riga
+  call "%EXECUTABLE%" start %CMD_LINE_ARGS% (startup.bat)
+  exec "$PRGDIR"/"SEXECUTABLE" start "$@" (startup.sh)
— e modificarla come segue
* call "%EXECUTABLE%" jpda start %CMD_LINE_ARGS% (startup.bat)
+  exec "$PRGDIR"/"$EXECUTABLE" jpda start "$@" (startup.sh)

All'interno dell'IDE occorre poi...

— creare ed avviare una apposita configurazione di debug remoto
*  Run — Debug configurations... — Remote Java application — right-click — New...
- ..eindicare la stessa porta di ascolto $PORT

— specificare opportuni breakpoint nei quali interrompere e monitorare I'esecuzione
« ...left-click oppure right-click — toggle breakpoint sulla fascia grigia a sinistra del codice, nellIDE
— eseguire il deploy dell'applicazione
— richiedere via browser la risorsa che determina I'esecuzione del codice contenente i breakpoint
— osservare |'esecuzione passo-passo (pause/play, step in/out/over)
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Esecuzione in modalita “debug locale” (consigliato)

* |n Eclipse seleziona la view "Servers"

= elenco dei server su cui € possibile effettuare il deploy di applicazioni Web
direttamente da Eclipse

= tramite Eclipse € possibile: avviare/fermare Tomcat, deploy/undeploy di
applicazioni, debug locale

* inoltre re-deploy automatico ad ogni compilazione di servlet e/o JSP
= per creare un nuovo server: File — New — Other... — Server — Apache

» Esercizio: provare ad avviare Tomcat da Eclipse ed effettuare
debug locale
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Apache Tomcat integrato con Eclipse

Il modo piu facile e intuitivo per utilizzare Tomcat € integrarlo con
I'IDE Eclipse
L’integrazione Tomcat-Eclipse permette:

= Start/Stop del Web Server direttamente dall’'IDE

» Modificare facilmente i parametri di configurazione tramite GUI

» Debug remoto local-like

» Visualizzare eccezioni/errori/output dei componenti lato Server direttamente
nella console dell’'IDE

» Gestire Server multipli
" ecC.

...ripartiamo da «abbiamo appena scaricato ed estratto tomcat
sul desktop»
= Potrebbe essere utile utilizzare Tomcat dalla vostra chiavetta USB

= questa soluzione porta le operazioni di deployment ad essere piu
time-consuming
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Integrazione Tomcat-Eclipse (1)

1. Per prima cosa ci serve la view «Servers»

1. Window > Show View > Servers ... nel caso non la trovaste direttamente
da Show View, continuare su Other > Server > Servers

2. Procedere su Create New Server

3. Da qui selezionare sotto la cartella Apache la versione di
Tomcat che avete scaricato, poi Next

8] eclipse-workspace? - Eclipse IDE
File Edit Navigate Search Project Run Window Help

4. Indicare il path del vostro Sroietopion s It > [ BRI e

= Servers Appearance

>
Tomcat R e
Perspective > @ Console Alt+Shift+Q, C
— ¥ Data Source Explorer
Navigation N
Web Browser > % Navigator (Deprecated)
Prefarcnces & Outline Alt+Shift+Q, O
. H 1 " I Project Explorer
5. e selezionate la giusta JDK :
9 Search Alt+Shift+Q, S
% Servers
& Snippets
Bl Task List Alt+Shift+Q, K
Other... Alt+Shift+Q, Q

6. Finish
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Integrazione Tomcat-Eclipse (2)

8 New server o X

Define a New Server g

Choose the type of server to create

Select the server type: 3

type filter text

v & Apache ~
# Tomcat v3.2 Server
8 Tomcat vA.0 Server
fi Tomcat v4.1 Server
# Tomcat v5.0 Server
8 Tomcat v5.5 Server
fi Tomcat v6.0 Server
# Tomcat v7.0 Server
8 Tomcat v&.0 Server
fi Tomcat v8.5 Server
# Tomcat v9.0 Server

& Basic
i Pl Evincloe Y,
Publishes and runs J2EE and Java EE Web projects and server configurations to a local Tomeat server.
Server's host name: " localhost
Server name: Tomcat v9.0 Server at localhost
Server runtime environment:  Apache Tomcat v9.0 ~| Add
Configure runtime
8 New Server o x
Tomcat Server H

© The specified Tomcat installation directory does not exist.

= Net> o

Nare:
[ Apache Tomcat vo.0 |
Tomaat nstallation directory

[ <your-unzipped-tomeat 9.0.22-folder> ] Browse.
Download and Insta

RE

Workbench default RE Instlle RS,

® <Back Next > Finish Cancel
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Integrazione Tomcat-Eclipse (3)

= Qra doppio click sulla voce di Tomcat comparsa nella vista
Servers

= Sotto Server Location selezionare:
= Use Tomcat installation

» |nfine salvare
= Provate a lanciare il Server

con il pulsante Play/Stop
= Provate a connettervi a
http://localhost:8080

Da questa finestra & possibile impostare
altri parametri di Tomcat, anche il Debug

(lo vedremo fra poco..) e ==
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Integrazione Tomcat-Eclipse (4)

» Questa € la pagina che dovrebbe comparire all’'indirizzo
localhost:8080

© © localhost8080

Home D i Config i Wiki  Mailing Lists Find Help

Apache Tomcat/9.0.22 J RPacHE s

= La configurazione di base
e terminata

Recommended Reading:
Security Considerations How-To

Server Status

Manager App
Manager Application How-To e
c i i ication How-To Host Manager

Developer Quick Start

Tomcat Setup Realms & AAA Examples Servlet Specifications

First Web Application JDBC DataSources Tomcat Vel

= Potete anche provare
differenti configurazioni per &y . wsssmes ey

restricted. Users are defined in:

Tomcat 9.0 Configuration The following mailing lists are available:
H SCATALINA_HOME/conf/tomcat-users.xml AT et
Tomcat Wiki tomeat-announce
In Tomcat 9.0 access to the manager I i Important announcements, releases, security
’ application is split between different users. Find additional important (Low volume).
. . Read more... imeeniy tomeat.users
Servers di Eclipse o e
Release Notes . taglibs-user
— ] Developers may be interested in: User support and discussion for Apache Taglibs
&hangeled ‘Tomeat 9.0 Bug Database tomeat-dev
Migration Guide e —— Development mailing list, including commit messages
Security Notices Tomeat 9.0 SVN Repository.
Other Downloads Other Documentation Get Involved Miscellaneous Apache Software
Foundation
Tomeat Connectors Tomeat Connectors Overview Contact
Tomeat Native mod_jk D i SVN Repositori Legal Who We Are
Tagibs Tomeat Native Mailing Lists Sponsorship Herltage
Deployer Wiki Thanks Apache Home
Resources
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Tomcat-Eclipse: «debug locale»

» Come sappiamo, il debugging & una pratica fondamentale

» Vediamo come eseguire il debugging di una Web application
server-side

= Andiamo nella vista Servers di Eclipse

= Doppio click Server Tomcat creato in precedenza

» Sotto General Information

= Click su «Open launch configuration»

» Andiamo sotto il tab «Source»

» Add > Java Project

= Selezionare il progetto di cui vogliamo fare il debugging, OK, Applica
» Riavviamo Tomcat in modalita debug

» cliccando sull'insettino, invece che il solito bottone play

» Possiamo ora sfruttare tutte le feature del debug locale dell’'IDE,
come breakpoint, step over, step into, ecc., per debugging di
applicazioni Web remote
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Firefox for Developer (Firebug) (1)

Cos’e Firefox for Developer?

E una versione del browser Mozilla Firefox gratuita e open
source pensata per gli sviluppatori Web

Universalmente riconosciuta come uno strumento indispensabile
per lo sviluppo di “rich internet application”

Funzionalita offerte
= Navigazione all'interno del DOM delle pagine web

= Analisi e modifica dellHTML e dei fogli di stile in tempo
reale

= Monitoraggio, debug e modifiche del codice Javascript in
tempo reale

» Visualizzazione nel browser, in tempo reale, delle modifiche
apportate
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Interfaccia Inspect di Firefox

= Consiste di 6 schede principali

Console: riporta log relativi al codice Javascript richiamato
dalla pagina, e permette la scrittura ed esecuzione di codice
aggiuntivo

HTML.: riporta il sorgente della pagina in esame evidenziando
le aree su cui si sposta il mouse

CSS. visualizza e permette di modificare gli stili associati ai
componenti HTML nella pagina

Script: supporta il debug del codice JavaScript eseguito dalla
pagina

DOM: riproduce la struttura ad albero del DOM della pagina e
ne permette modifiche

Net: analisi dei tempi di download di ogni risorsa nella pagina
e delle connessioni effettuate
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Firefox Vs Firefox for Developer

La feature che ci interessa maggiormente, I'lnspect Element, &
presente in entrambe le versioni, ma ecco alcune differenze:

= Profili Separati: si mantiene 'ambiente di sviluppo separato
da quello di browsing standard, rendendolo specificamente
configurabile solo per lo sviluppo web

= Feature: nella versione for Developer si ha accesso a
funzionalita esclusive per lo sviluppo

= Supporto: lead time di 12 settimane sul supporto per le
ultime aggiunte agli standard web

= Configurazione: preferenze e configurazioni di default per
sviluppatori

» Tema: tema Dark per sviluppatori
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da quello di browsing standard, rendendolo specificamente
configurabile solo per lo sviluppo web

= Feature: nella versione for Developer si ha accesso a
funzionalita esclusive per lo sviluppo

= Supporto: lead time di 12 settimane sul supporto per le
ultime aggiunte agli standard web

= Configurazione: preferenze e configurazioni di default per
sviluppatori

» Tema: tema Dark per sviluppatori
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Firefox Inspect Element: un esempio

Vediamo I'Inspect Element tool “all'opera” sulla pagina web di Lisa

Simpson:

J& laria Bartolini's Home Page

% | || Tecnologie Web T (llaria Bartolini]

letteratura

(p

J[=[5[0]

% | Edit | body < htmi

Stylev | Computed Layout DOM

<!DOCTYPE HIML PUBLIC "-//W3C//DTD HIML

= <html>
[# <head>
Bl <body>

B <div id="navbar" clas

N" "http://wwv.v3.org/TR/html4/loose.dtd">

s="centrato">

<& href='

<a href="¢interes

<hr>

ione">

si">Interessi
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body { video.css (line 2)
background-color: #80B3FF;
coloxr: black;
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bedy { video.css (line 2)
background-color: #80B3FF;
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Firefox vs. Google Chrome Developer Tools

Cos’é Chrome Developer Tools?

E una suite di tool inclusi nel browser Google Chrome le cui
funzionalita sono del tutto analoghe a quelle offerte dall'Inspect
Element di Firefox nella sua versione completa

& Developer Tools - http://www.google.com/ @Elg

B e @ A0 d@E Q

Elements = Resources Network Scripts Timeline Profies Audits Console Search Elements

Strumento alternativo per lo sviluppo di “rich internet
application’

Funzionalita offerte

= Navigazione all'interno del DOM delle pagine web

= Analisi e modifica dellHTML e dei fogli di stile in tempo reale

= Monitoraggio, debug e modifiche del codice Javascript in tempo
reale
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Tips & Tricks

|l filesystem dei lab € usualmente accessibile in sola lettura

= solo la directory c:\temp € accessibile in scrittura; il suo contenuto
viene cancellato sistematicamente

= ogni utente ha a disposizione 200MB di spazio per il profilo

Si consiglia vivamente di presentarsi alle esercitazione con una
memoria esterna (512MB sono piu che sufficienti)

= tale memoria verra utilizzata per contenere il workspace di Eclipse e
le versioni portable di Tomcat

» in tal modo sara possibile salvare il lavoro svolto, ad esempio, i
progetti realizzati, la configurazione del workspace ed il settaggio dei
server

Infine, alla pagina “Laboratorio” del sito del corso
(http://lia.disi.unibo.it/Courses/twt2021-info/) potete trovare:

= |ink al software utilizzato nelle esercitazioni e relativa manualistica
= un progetto Eclipse ANT-based pronto all’'uso
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